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OOVVEERRVVIIEEWW  
 
 

The American Legion Auxiliary Management Information System (ALA MIS) is used by units and departments to 
manage members, units, departments and leadership information. Units are only allowed to designate up to two 
users for login access. This cost is $10 per login. This is collected through the department and transmitted to the 
NHQ. The department headquarters authorizes who has access. Units must contact their department with the 
name of the member who should have access to ALA MIS along with the member’s email address, member ID 
number, and phone number for the person at the unit who will be using the account. 
 
Units can stay informed of important reminders from National Headquarters by viewing our announcements on 
ALA MIS.  Units are also able to make updates, perform searches, and view unit reports. 
 
Make Updates 

 Add new members 

 Update member information (name, address, phone number, email address, birthday, marital status) 

 Update Auxiliary magazine preference (mail, online, or no magazine) 

 Update solicitation preference 

 Request to have no mail/phone calls 

 Add unit leadership positions  
 

Perform Searches 

 See if dues have been applied to a member in the unit 

 View a member’s join date 

 View a member’s membership activity  

 Search for members in the unit 

 Filter and view only expired, junior, or adult members 

 View a member’s continuous years of membership 

 View a member’s member ID number 

 View a member’s paid through date 

 See if a member is in a special category such as Paid Up For Life (PUFL) member or  Honorary Life 
member (HLM) 

 
View Reports 

 View Unit Reports to export into Excel, Word, or as a PDF document 

 Use Excel exports to do mail merges if the unit needs to send letters, emails, or make labels for members 

 Use Membership Roster to view all members in their unit 

 Use Leadership Roster to view all leaders in their unit 

 View the members who have paid dues report 

 View the members who have not paid dues report 
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AACCCCEESSSSIINNGG  AALLAA  MMIISS  
 

Step 1: URL (website address) 
To access the ALA MIS, open Mozilla Firefox or Internet Explorer, enter as the URL: https://members.legion-
aux.org.  The ALA MIS Login Screen should appear.  We do not recommend using Chrome, as it can hide some 
information. 

 

 

 
 

Bookmark this page from Firefox by hitting Ctrl+D.  Next time you need to access ALA MIS, open up Firefox and 
go to the Bookmarks menu.  Select the American Legion Auxiliary - Login page instead of typing in the URL. Or 
add this page to your Favorites from Internet Explorer by going to your Favorites menu and selecting Add to 
Favorites. 
 

Step 2: Username/Password 
Enter your Username – Usernames are NOT case sensitive 

Enter your Password – Passwords are case sensitive. Do NOT share your password with other members of your 
unit. If a new user is appointed, then contact your Department Headquarters for a new ALA MIS account.  Firefox 
may ask you if you want it to remember your password.  Select Never Remember Password for This Site. 

This is where you type or paste the URL. If you do 
not see this navigation toolbar, hit CTRL+L.  

https://members.legion-aux.org/alamis
https://members.legion-aux.org/alamis
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TTAASSKK  CCEENNTTEERR  
 

 
The Task Center is the Homepage for the ALA MIS.  Click the Task Center button from anywhere on the website, 
and you will return to the Task Center.  

 

1 
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Site Map 
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Click to logout 
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MMYY  PPRROOFFIILLEE  
 
 

For security reasons, please LOGOUT and close your browser each time you exit the system. To logout, select the 
down arrow next to My Profile and then select Logout.  You will not be able to view or edit your profile. 

 

  

  

  

UUNNIITT  NNUUMMBBEERR  OORR  DDEEPPAARRTTMMEENNTT  NNAAMMEE  
 

 
The unit number will always be displayed in the middle of your screen in a yellow box no matter where you are 

on the site. Your unit’s contact information can be found by clicking on your unit number in the yellow box.   

   

  

  

  

CCOONNTTAACCTT  IINNFFOORRMMAATTIIOONN  
 

 
Your unit’s contact information is displayed by clicking on the yellow box. It can be hidden by clicking on it again.  

 

2 

3 

4 

Click to view/collapse 
contact information 
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Unit 
Your unit’s number, legal name, mailing (permanent) address, billing address, telephone number, and website 
can be found in this area.  The remittance address is where unit dues should be mailed. That address may not be 
the same as the unit’s mailing address. To make changes to the unit’s telephone numbers, email address and 
website, go to the Unit tab and edit the unit’s information.  Any changes to the unit’s remittance address should 
be sent to your department.  Changing the unit’s dues remittance address does not change the unit’s dues 
remittance person and vice versa.  The unit’s dues remittance person is a leadership position called Unit Dues 
Remit.  The Unit area (Section 8) of this manual will tell you how to update leadership positions in ALA MIS. 
 
Please note that you will be able to see their mailing (permanent) address and other unit information, but you 
will not be able to change it. To make other changes to the unit’s information, please contact us.  Units cannot 
update their dues remittance address using ALA MIS.  This can only be done by Departments or National 
Headquarters. 

AANNNNOOUUNNCCEEMMEENNTTSS  
 
 

The information in the Announcements section is controlled by ALA National Headquarters.  See this section for 
dates and times for planned system maintenance, deadline reminders, etc. 
 

MMEEMMBBEERRSS  TTAABB  
 

 

Add a New Member 
 

Step 1: Navigation 

[Members]   Add New Member  Add New Member 
 

 Step 2: Action Steps 
 

1. Overview 
Please search for new members before adding them to the database.  This cuts down on the number of 
duplicate records we have in the database.  See the Unit Handbook for guidelines for new members as 
well as eligibility requirements. After you add a new member, she will be entered into the system as a 
Pending Member/ Jr Member.  After payment is processed, the member will become an Active 
Member/Jr Member.  
 

2. Selection 
Fill in the information for each New Member (Required fields have an *) then select “Add Person” at the 
bottom of the screen. 
 

5 

6 
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Date of birth is required if you are adding a junior 
member or she will be added as a senior member 
with senior rates if no date of birth is entered. 

You must hit the ADD PERSON button or your 
member will not be added. 

If you make a mistake after 
you have clicked Add Person, 
you can click here to Edit 
that member’s info or delete 
that member altogether. 
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To verify that you have successfully added the member, their name and email will appear at the bottom 
of the screen.  (See example above, Test Person) Repeat for each member you wish to add and click 
Continue.  
 
Note:  If you click Continue without clicking “Add Person” the member will not be added and you will have 
to reenter the member’s information. 
 
Beneath the members you add during this Membership Action, is a list of Pending Members/Junior 
Members recently added to this unit.  Pending members cannot be updated or changed here.  They are 
listed as a reference to help prevent the entry of duplicate members.  Once your department has paid 
dues for the Pending Members, they will become active members and will no longer appear in this list. 
 

3. Additional Info 
Here you can change the Join Date if applicable for each member.  Enter a join date before September 1 
of the current membership year and the member added will be billed for current year dues. Enter a join 
date on or after September 1 of the current membership year and the member will be billed for next year 
dues.  
 
Example:  On 10/16/2010, Jane Smith is added with a Join date of 8/15/2010. Jane is billed for 2010 Dues 
but if Jane Smith was added on the same day with a Join date of 9/26/2010, Jane will be billed for 2011 
Dues.  

 
 

4. Validation 
Please review the information to ensure accuracy and enter your electronic signature exactly as it 
appears on the screen. Then click “Continue” to submit your transaction. 
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5. Receipt 
You have successfully added a Pending Member.  Print and keep a copy of the displayed receipt for your 
records.   
To print a receipt either: 

 Hit Ctrl+P  

 Or go to the upper left hand corner of the page and click on File>Print 
 

 
Another window will open so you can select different options or click ok to proceed with print job.   

 
 
Important:  The system will now complete an automated process.  Please remember that units cannot 
pay dues, but your department can pay the member’s dues after the automated process is completed.  
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Edit Member Information 
 

Departments/Units can view and edit demographic, personal, and membership information for the members in 
their Department/Unit. They can also see a report of all of an individual member’s activities and/or history of all 
changes made to the member’s record. 
 

EEddiitt  MMeemmbbeerr  PPrrooffiillee  
 
Step 1: Navigation 

[Members]   Edit Member Info  Edit Member Profile 
 

Step 2: Find Member 
This screen displays basic information for all of the Current Active Members of this Unit in alphabetical order by 
last name.  To see more detailed information and/or to make changes, first find the member using one of the 
following methods:  
   

 Scroll down to the member 

 Use the Filter to display only Senior or Junior Members – (Using the filter is particularly helpful when 
dealing with larger Units). Deceased, pending, and former members will not be displayed. 

 Type in any part of the member's First or Last Name and select the member from list of results 
 

 
 

 
 

   

Filter for Senior or Junior Members To search for a member, 
type any part of the first or 
last name 

#123456789 1234 Test St 

City, ST 01234-5678 
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Step 3:  View/Edit Member Profile Information 
To view/edit the profile information for a member, click  

 
 
Member profile data is divided into 5 tabs:  
 

 Member 

 Address 

 Background 

 Personal 

 Communication 
 

Each tab displays different fields, some of which can be edited by Units and others are Read-Only. To make a 
change to a field, type over the current data and click Save. To go back to the roster, click Return To Roster. 
 
Please see the following table for a list of all fields available to view in the ALA MIS and which ones Units have 
rights to change. 

 

123456789 
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MEMBER DATA/FIELD LIST 
 

MEMBER TAB 
 

Field 

Membership ID 

First/Middle/Last Name/Informal First Name 

Membership Type Description 

 MAM – Senior Member 

 MYM – Junior Member 

 PAM – Pending Member 

 PYM – Pending Junior Member 

 XAM – Expired Member 
(expired 2 years or less) 

 XYM – Expired Junior Member (expired 2 years or less) 

 FAM – Former Member (expired more than 3 years) 

 FYM – Former Junior Member (expired more than 3 years) 

 DMAM – Deceased Member 

 DMYM –  Deceased Junior Member  

Membership Category Description 

 CL – Cancelled Membership  

 HLM – Honorary Life Member 

 SLM – State Life Member (CO, NE, ND  states ONLY) 

 VIM – Paid Up For Life 

 Home Phone 

Cell Phone 

Email Address 

 

ADDRESS TAB 
 

Field Note/Membership Action** 

Permanent Address   

Alternate Address   

Seasonal Address 
After putting in the Seasonal address, you 
MUST go to the Communications tab and 
enter the Seasonal Date information. 
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BACKGROUND TAB 
 

Field Note/Membership Action** 

Join Date Contact NHQ to change 

Continuous Years Requires NHQ approval 

Initial Unit Contact NHQ to change 

Current Unit Must complete a Transfer Action to change 

Current Dept Must complete a Transfer Action to change 

War Era   

Volunteer Interests   

Branch Service/Legion Information   

Related Type   

Veteran related Thru Contact NHQ to change 

 

PERSONAL TAB 
 

Field Note/Membership Action** 

Marital Status   

Date of Birth   

Age in Years Change the date of birth to alter age in years 

 

COMMUNICATION TAB 
 

Field Note/Membership Action** 

Magazine Preference 
If an email address is entered, a member 
can receive a link to go online and view 
magazine vs. a physical copy. 

No Magazine   

No Mail   

No Department Publication   

No Solicitation   

No Calls   

Season Begin Day 
For seasonal addresses – Enter the Begin 
and End Month and Day. The Preferred 
mail address will change used during this 
time every year 

Season Begin Month 

Season End Day 

Season End Month 

Temp Seasonal 

 
Note:  All changes made by the National Headquarters, the Department, Unit or Member will be listed in the 
Change Log – A report that details every change made in the system – What the old data was, the new data, 
when the change was made and who made it.  
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VIEW MEMBER ACTIVITY 
 
Step 4:  View Member Activity  
To view a list of member activities, click  
 
This is a report of all of activities for an individual member.  Activities included in this report are: dues payments, 
changes to leadership positions and committees, continuous year adjustments, and event attendance.  

 

 
 

VIEW MEMBER CHANGE LOG 
Step 5:  View Member Change History 
To see a list of the changes that have been made to this members profile/record, click 
 
In the Reports area, Units can see a report of all of the changes made to the member records in their entire Unit.  
Here the same information is displayed for each individual member. 
 

xxxxx Test, Olivia  Member ID# 987654321 
 

Olivia Test 

111111111 

123456789 

123456789 

123456789 

123456789 

123456789  

 

Auxiliary 

1234 MAPLE 
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UUNNIITT  TTAABB  
 

 

Edit Unit Leaders 

GGuuiiddeelliinneess  
ALA policies state that in order to be selected for a leadership position, a member must be in good standing and 
dues must be paid current.  In order to edit leaders for a Unit, you will need to know the name of the member, 
their leadership position and the effective dates. 

PPrroocceessssiinngg  

 
Step 1: Navigation 

 [Unit]   Edit Unit Leaders 
 

Step 2: Action Steps 
 

1. Selection 
The list that displays contains all available Unit level leadership positions and the leaders currently 
assigned to those positions.   

 
Unit Leadership Positions as of September 20, 2013 

 

Unit AEF Chairman Unit Legislative Chairman 

Unit Americanism Chairman Unit Liaison Child Welfare Foundation Chairman 

Unit Cavalcade Of Memories Chairman Unit Membership Chairman 

Unit Chaplain Unit National Security Chairman 

Unit Children & Youth Chairman Unit Past Presidents Parley Chairman 

Unit Community Service Chair Unit Poppy Chairman 

Unit Constitution & Bylaws Chairman Unit President 

Unit Director Of Hospital Volunteers Unit Public Relations Chairman 

Unit Dues Remit Unit Sergeant--At -Arms 

Unit Education Chairman Unit Secretary 

Unit Field Service Director Unit Treasurer 

Unit Finance Chairman Unit UD&R Chairman 

Unit Girls State Chairman/Director Unit VA & R Chairman 

Unit Historian Unit Vavs Representative 

Unit Junior Activities Chairman Unit Vice President 

Unit Leadership Chairman 
  

To edit or assign new leaders, select the positions that will change by checking the box next to the 
position and click continue. 
 

7 
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2. Additional Information 
Click the Find a Member link next to the leadership position to assign a new leader to each position or to 
mark a position vacant – do this one position at a time. 
 

 
 
The following Dialog Box will appear.  Enter search criteria to find the member. Click the checkbox to 
select the member for the position. 
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The selected members name will appear next to the position title.  Repeat for each leadership position 
and fill in the appropriate effective date.  
 

 
 
Note: The effective date you put in will be entered as both the end date for the old position holder and the 
begin date for the new position holder.  For this reason, leadership reports ran the day of the position 
change may show both leaders. If you need an accurate leadership report the day of the position change, 
send the request to the ALA MIS helpdesk. 
 

3. Validation 
Please review the information to ensure accuracy and enter your electronic signature exactly as it 
appears on the screen. Then click “Continue” to submit your transaction. 
 

4. Receipt 
You have successfully changed the leadership positions for this Unit. 
 
Please allow 15-20 minutes for the changes to take effect and overnight before running any leadership 
report.  

 

Edit Unit Information 
 

Step 1: Navigation 

[Unit]   Edit Unit Profile 
 
 

 Step 2: Edit Profile 
The Unit profile data is divided into 2 tabs:  

 Unit Contact 

 Unit Info 
 

Each tab displays different fields, some of which can be edited by Departments and/or Units and others are Read-
Only.  
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Unit Data Field Information 

 
UNIT CONTACT TAB 

 

 
 

Field 
Dept 
Edit 

Unit 
Edit 

Note/Membership Action** 

Unit Number No No Cannot be changed 

Legal Name No No Can only be changed by National 

Permanent Address No No Can only be changed by National 

Remit to Address for Membership Dues Yes No This is the address where Unit dues are sent 

Phone Yes Yes   

Fax Yes Yes   

Email Address Yes Yes   

Website Yes Yes   
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UNIT INFO TAB 
 
 

 

Field 
Dept 
Edit 

Unit 
Edit 

Note/Membership Action** 

# Jr Members 

No No All of these fields are calculated nightly and can be 
changed by the Unit/Department by performing various 
membership actions – i.e. paying dues, adding members, 
etc. 

# Sr Members No No   

# VIM members No No   

# Paid Dues Members No No   

# Unpaid Dues Members No No   

E Unit No No   

Widow Unit No No   

EIN Number No No   

Unit Info Legal Name No No Can only be changed by National 

Division/District/County No No  Can only be changed by National 

Division/District/County No No  Can only be changed by National 

Charter Date No No Can only be changed by National 

Unit Number No No Cannot be changed 

Department No No   
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Unit Reports 
 

MMeemmbbeerrsshhiipp  RRoosstteerr  
The Membership Roster includes all members in the unit. This list includes junior members.  This list excludes 
expired and former members. Expired members are defined as members that expired 2 years ago or less (have 
not paid dues in two years). Former members are defined as members that have expired 3 years or more (have 
not paid dues in three or more years). 

LLeeaaddeerrsshhiipp  RRoosstteerr  
The Leadership Roster includes the names and contact information for the unit leaders.  It also includes their 
position. To edit or add additional leaders, please go to the unit tab and edit unit leaders. 

DDuueess  RReeppoorrttss  

UNIT DUES PAID ONLINE  
This report is a listing of all members who have either paid their dues online or by phone to NHQ.  
 

UNIT PAID DUES ROSTER 
The Paid Dues Roster Report includes a list of all members who have paid dues for the year that you selected and 
they are currently in the unit you have pulled up.  It doesn’t matter what unit those members paid their dues to 
so this report will include members who transferred into the unit, but paid their dues to their old unit before they 
transferred into their new unit.  It includes the member’s ID number, name, address, whether the member has a 
good address, the member type, the number of continuous years of membership, and the member’s date of 
birth.  This report will also tell you the total number of members that have paid for the year that you selected.  
 

UNIT UNPAID DUES ROSTER 
The Unpaid Dues Roster Report includes a list of all members who have not paid dues for the year that you 
selected.  It includes the member’s ID number, member type, name, address, phone number, email address, and 
paid through date. 
 

UNIT DUES ACTIVITY REPORT 
The Dues Activity Report includes a list of all members who have paid dues for the year that you have selected. It 
also tells you the date that the member paid dues and the amount of the dues they paid to national.  This report 
also includes the member’s name and ID number.  You can choose a date range with this report.  You can also 
sort by the transaction date.  Lastly, this report tells you the total amount that was for national dues by this unit 
for the date range selected.  To enter a date range, enter the minimum date in the Transaction Date Greater than 
or Equal Date Entered here. Enter the maximum date in the Transaction Less than or Equal Date Entered here. 
The example below would find all 2017 unit dues paid between 7/1/2016 and 10/1/2017. 
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RREEPPOORRTTSS  OOVVEERRVVIIEEWW  
 

This is a general overview of ALA MIS Reports. Please see the unit report section for a detailed list of all the 
reports, descriptions, uses, etc.   

 

Step 1: Navigation 
Navigate to the Report.  Unit Reports are located under the Unit Tab.  

 
Step 2:  Select Report 
Example:  [Unit]  Unit Reports  2017 Reports   Unit Paid Dues Roster 

 
On the Report toolbar, you can scroll through the pages using the right and left arrows, adjust the size of the 
page view, search for a record in the report, export all records, refresh the data or send the report to print. 

 

 
 

Export a Report  
 
To Export a Report to Excel, Word, or a PDF document 
 

1. Navigate to Report 
2. Filter and sort report as needed 
3. Click square that has a white box and green arrow inside of it and then select the desired format 
4. Click the Export link 

 

 
 

5. This will open the below Dialog Box.  Choose Open or Save File 
 

Refresh Export Search 
Last Page 

Next Page 
Previous Page 

First Page 
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6. The message below will appear on the bottom right of your screen.   
 

 
 

7. Select your File Export  or wait for it to pop up on your screen. 
8. The file will open in Microsoft Excel, Word, or Adobe PDF. 
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EExxcceell  
 
Excel exports will open up an Excel spreadsheet.   
 

 
 
The name of the report will usually appear in row 1. The name of the department or unit will usually appear in 
row 2.  Additional rows may have more detailed information.  If you want to sort your data, then you will need to 
delete the first couple of rows so only the header row appears in Row 1 and the remaining rows contain data.  To 
delete the entire row (rows 1-3 and row 5) you need to select it and then right-clicking and select DELETE. 
 
Next, you will need to unmerge the cells. To unmerge cells, go to your Home menu and go to Merge & Center in 
the Alignment section and choose Unmerge cells.  
 

 
 

Name of Report 

Name of Unit or 
Department 

Header Row 
(name of columns) 

Additional detailed 
information 
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Next, you will need to delete any blank columns you may have.  These columns don’t have a header name. To do 
this, select the column, right-click and choose DELETE. 
 

 
 
Save your file by hitting SAVE AS and naming your document in a location you will remember. Now you should be 
able to sort your data in Excel or even do a mail merge from Word. 
 

WWoorrdd  
 

Word exports will open up a Word document.  You can delete rows with this format, but you will not be able to 
sort your data.  Sorting can be done in Excel from the Data menu. 
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PPDDFF  
 
PDF exports will open up a PDF document in Adobe. You cannot edit data with this format. 
 

 
 

 

DDEEPPAARRTTMMEENNTT  TTAABB  
 
 

 
Only Departments have access to the Department tab. 

8 
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HHEELLPP  TTAABB  
 
 
 

Training Materials  
 
Training materials and system documentation can be found under the Help tab of the website. Training videos on 
a variety of tasks and membership actions will be uploaded at a later date. 
 

Helpdesk Emails 
 
If you need assistance using the ALA MIS, check for solutions in the applicable section of the Training Materials.  If 
you still need assistance, please contact the Helpdesk via phone: (317) 569-4536 or email: alamishelp@legion-
aux.org 
 
When sending an email, please be sure to include the following: 

 Your name 

 Department 

 What browser were you using?  Example: Mozilla Firefox, Internet Explorer, Safari, etc. 

 What were you doing when you encountered the issue? Example: I was on the Checkout step of paying 
dues, I was trying to run the Dues Reconciliation Report, I was trying to update an address, etc. 

 If you encounter an error message, please note the exact time the error occurred. 

 If at all possible, please include a member name and membership ID tech support can reference. 
 
 
NOTE: 

Using the Helpdesk Email and Phone line instead of individual staff members phones/emails allows  
ALA MIS issues to filter through ONE source. This helps us to identify trends/common issues more quickly, 
prioritize needs, track issues, and improves response times while minimizing duplication of efforts among 
staff.   Sending your ALA MIS issues directly to staff phones, emails or both ultimately results in slower 
response times and ineffective service. 
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